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What is Microsoft Copilot?

Microsoft Copilot is your personal 
AI companion. It’s a conversational 
chat interface that offers a range of 
functionalities:

1. Information Retrieval: You can ask Copilot
specific questions and get answers. It’s
like having a knowledgeable friend at your
fingertips.

2. Text Generation: Copilot can generate text
for you. For instance, if you need a concise
summary of a memo, just ask, and Copilot will
provide it.

3. Image Creation: Describe what you want, and
Copilot can create images based on your text
prompts.

4. Coding Assistance: Copilot can even write
code in various programming languages,
including JavaScript, C, and Python.

Keep in mind that Copilot is continually 
evolving, so its features and capabilities 
may change over time. You can access 
Copilot in different places:

• Copilot Website: Visit the Copilot website to
use plug-ins, book restaurant reservations,
and more.

• Windows Sidebar: If you’re using Windows,
Copilot in the sidebar allows you to change
settings, summarize selected text, and
perform other tasks.

• Bing Search and Bing Mobile App: Copilot
is integrated into Bing, allowing you to switch
between AI and regular search.

• Edge Web Browser: In Microsoft Edge,
Copilot resides in the sidebar and lets you
interact with text and create images.
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What is the Value in Having 
Copilot Turned On?
Microsoft Copilot offers a variety of features that can significantly enhance you
productivity and creativity. Here are some of the benefits to having Copilot turned on:

Change System Settings  
on Windows 11

Copilot allows you to manage system settings with simple prompts. 
Instead of navigating through different screens, you can ask Copilot to 
perform tasks like enabling “do not disturb”, adjusting volume levels, 
changing wallpapers, and more.

Efficient Task Execution Copilot streamlines daily tasks, making them easier to tackle. Whether it’s 
composing content, summarizing information, or creating images, Copilot 
provides efficient solutions within the Windows 11 experience. 

Boosted Creativity Copilot assists in planning, brainstorming, and collaborating seamlessly. 
It helps you stay in sync with team members, ensuring everyone is on the 
same page.

Integration Across 
Microsoft Products

Copilot isn’t limited to Windows 11. It’s available across various Microsoft 
products, including Microsoft Paint, Photos apps, Microsoft Edge, 
Snipping Tool, and the web. 

Enhanced Understanding Copilot’s comprehensive answers to virtually any question help you gain 
deeper insights and understanding of various topics. 

Copilot is your AI companion, ready to assist you with 
tasks, creativity, and knowledge—all at your fingertips!



How Will Copilot Integrate 
into Microsoft 365 Apps?
Microsoft Copilot is seamlessly integrating into various Microsoft 365 apps, enhancing 
your productivity and creativity. Here’s how it will present in each of these applications:

Microsoft Teams
Copilot will be available within Teams, 
allowing you to collaborate more effectively. 
Whether you’re composing messages, 
scheduling meetings, or managing tasks, 
Copilot will be your AI companion, aiding and 
streamlining your workflow. 

Power BI (Preview)
In Power BI, Copilot will offer interactive features. 
You can open the Copilot pane and ask it to 
create report pages, summaries, or narrative 
visuals. Copilot’s capabilities will help you analyze 
data and generate insights more efficiently. 

Microsoft Viva,
Power Platform, and More
Copilot’s reach extends beyond the core 
apps. It will integrate with Microsoft Viva, 
Power Platform, and other productivity 
tools, shaping the future of work and 
enabling you to achieve more. 

Word, Excel, PowerPoint,
Outlook, and OneNote
Copilot will be embedded directly into these 
familiar Microsoft 365 apps. As you work on 
documents, spreadsheets, presentations, emails, 
and notes, Copilot will unleash creativity, unlock 
productivity, and enhance your skills. Imagine 
having an AI collaborator right alongside you as 
you create content, summarize information, and 
explore new ideas.

Copilot will be your trusted co-pilot across the Microsoft 
ecosystem, making your work smarter, more efficiently, 
and with greater innovation! 
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How Does Copilot Secure Data?
Microsoft Copilot for Microsoft 365 prioritizes data security and privacy.
Here’s how it ensures the protection of your organizational data:

1. Access Control:

Copilot connects to your organizational data
through Microsoft Graph. It adheres to the same
access controls as other Microsoft 365 services.
This means it only accesses content that you
have permission to view, ensuring unauthorized
data remains off-limits.

2. Compliance Commitments:

Copilot complies with existing privacy,
security, and compliance standards for Microsoft
365 commercial customers. These include the
General Data Protection Regulation (GDPR) and
the European Union (EU) Data Boundary.

3. No Training on User Data:

Prompts, responses, and data accessed
through  Microsoft Graph are not used to train
foundation language models (LLMs), including
those used by Copilot. Your proprietary
organizational data remains confidential.

4. Encryption:

Service-side technologies encrypt customer
content both at rest and in transit. This robust
encryption ensures data security throughout
its lifecycle.

5. Tenant-Level Protection:

Copilot is architected to protect tenant,
group, and individual data. It prioritizes
safeguarding against data leakage, which is a
critical concern for organizations.

6. Regulatory Compliance:

Copilot meets regulatory requirements,
providing peace of mind for organizations. It
aligns with privacy laws and data residency
commitments.

7. Transparent Evolution:

As Copilot evolves, it continues to uphold
these security and privacy principles. Regular
updates ensure it remains a trusted AI
companion.Remember, Copilot is designed to enhance 

productivity while respecting your data privacy.
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Copilot Security Best Practices
When it comes to securing your data while using Microsoft Copilot for Microsoft 365, 
there are several best practices to follow:

Risk Assessment

Permissions Cleanup 
and Policy Enforcement

Maintain
Security Measures

Copilot’s reach extends beyond the core apps. It will 
integrate with Microsoft Viva, Power Platform, and other 
productivity tools, shaping the future of work and enabling 
you to achieve more.

Regularly review and clean up permissions. Ensure that 
users have just-enough-access permissions—only the 
necessary access required for their roles. Enforce policies 
to maintain data security and prevent unauthorized 
access.

Continuously monitor and maintain your security 
measures. Regularly update policies, review access 
controls, and stay informed about security best practices. 
This proactive approach helps safeguard your data 
effectively. 

Remember, these practices contribute to a more secure experience 
with Microsoft Copilot, enhancing your data protection and privacy! 
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What O365 Tools Will 
Copilot Integrate With?
Microsoft Copilot for Microsoft 365 seamlessly integrates with several 
essential Office 365 tools, enhancing your productivity and creativity.
Here’s a breakdown of the integration:

Word, Excel, PowerPoint, Outlook, Teams, and More

Copilot works alongside popular Microsoft 365 Apps, including:

• Word: Enhance your document creation and editing.
• Excel: Get intelligent assistance with spreadsheets.
• PowerPoint: Elevate your presentation design.
• Outlook: Optimize email composition and management.
• Teams: Collaborate effectively within Teams.
• And more! Copilot is your co-pilot across these familiar apps,

unlocking creativity and productivity.

OneDrive Integration

Having a OneDrive account is essential for features within Copilot. 
It enables saving and sharing files seamlessly. 
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What O365 Tools Will 
Copilot Integrate With?

New Outlook for Windows

For seamless integration with Outlook, use the new Outlook for Windows, currently in 
preview. You can also switch to Outlook Mobile to access the new experience. 

Microsoft Loop and Whiteboard

Copilot integrates with Microsoft Loop and Microsoft Whiteboard.
Ensure these are enabled for your tenant to leverage Copilot’s capabilities.
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What O365 Tools Will 
Copilot Integrate With?
Foundational capabilities of Copilot

Natural Language 
Understanding (NLU) 

Copilot can understand and generate human-like responses in multiple 
languages. It comprehends context, interprets user intent, and provides 
relevant information.

Content Generation Copilot can create imaginative content such as poems, stories, code, essays, songs, 
and more. All you need to do is give it a simple prompt and it handles the rest.

Information Retrieval
Copilot can search the web using Bing and provide relevant information. 
Whether it’s facts, summaries, or answers to specific questions, Copilot has 
you covered.

Structured Responses
Copilot can organize information into tables, lists, and markdown formatting 
for readability. It’s like having a helpful assistant who knows how to present 
data effectively.

Error Detection 
and Correction

Copilot can identify errors in conversations and rectify them. If it 
makes a mistake, it simply apologizes and provides accurate data 
based on the parameters of your original prompt.

Image Description
If you upload an image, Copilot can describe its contents. Simply send an 
image to Copilot and it will provide an accurate, detailed description.
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What O365 Tools Will 
Copilot Integrate With?
Copilot web grounding refers to the process by which Copilot gathers information 
from the web to enhance its responses. When you ask a question or provide a prompt, 
Copilot can search the internet using Bing and retrieve relevant information. This helps 
ensure that the answers provided are accurate, up-to-date, and well-informed.

Copilot’s commercial data protection ensures the safety and privacy of workplace
AI-powered web chats. Here’s how it works:

Authentication and Authorization

Data Encryption

• Users access Copilot using their work or school (Entra ID) account.
• Tenant and user information is removed from chat data at the start of a session.
• Search queries triggered by Entra ID users are not linked to specific individuals or organizations.
• Microsoft doesn’t retain prompts or responses from Entra ID users.

• Chat data sent to and from Copilot is encrypted in transit (TLS 1.2+)
and at rest (AES-128) during the chat session.

• Microsoft has no ‘eyes-on’ access to this data.



What O365 Tools Will 
Copilot Integrate With?

No Training Data

• Because prompts and responses aren’t retained, they can’t be
used for training the underlying large language model.

Non-Targeted Advertising

• Advertising shown to Entra ID users isn’t based on workplace identity or chat history.

These data protections extend to eligible Entra ID user chats in Copilot across various platforms, including 
copilot.microsoft.com, Bing, Edge, and Windows. Additionally, Copilot doesn’t retain chat history or 
offer usage reporting when commercial data protection is enabled. Remember, Copilot is grounded in 
data from the public web (Bing search index) and doesn’t have access to organizational resources within 
Microsoft 365, such as documents or emails.  
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Different Copilot Use Cases 
Microsoft Copilot in Word to enhance your writing and document creation. Copilot 
in Word is a powerful feature that leverages AI to assist you throughout your writing 
process. Here are some key tips and tricks:

1. Drafting New Content with Copilot:

• When starting a new document or adding a
new line, the Draft with Copilot experience
appears.

• Simply type or paste your prompt, such as
“Write an essay about baseball” or “Create a
paragraph about time management.”

• If you have a Copilot for Microsoft 365 license,
you can also reference up to three existing files
to ground the content Copilot drafts.

• Copilot will generate new content based on
your prompt. You can choose to keep it, discard
it, or ask Copilot to regenerate a different
version.

• Use the Inspire Me button to have Copilot
continue writing based on existing content in
your document.

2. Transforming Existing Content:

• Copilot not only helps you create new
content but also transforms your existing
content.

• If rewriting and editing take more time than
writing from scratch, Copilot can assist.

• Fine-tune your existing content by providing
instructions like “Make this more concise.”

3. Chat with Copilot:

• Open the Copilot pane via the Copilot icon
in the ribbon’s Home tab.

• Chat with Copilot allows you to ask
questions—broad or specific—about your
document.

• It provides helpful answers and actions
based on your content or obtains additional
information from external resources.

4. Enabling Copilot in Word:

•	To enable Copilot in Word, go to File>Options>Proofing>AutoCorrect Options>Use
Microsoft Copilot.

The Ultimate Guide to Copilot | 12 



Different Copilot Use Cases 
Microsoft Copilot in Excel to enhance your data analysis and productivity. 
Copilot in Excel is a powerful feature that combines AI with your natural 
language queries. Here are some tips and tricks:

Analyze and 
Visualize Data

Effortlessly Highlight 
and Filter Data

Generate Formula 
Columns

Getting Started

• Copilot helps you explore and understand your data better.
• To use Copilot, format your data as a table in your spreadsheet.
• Select the data, click the Copilot button in the ribbon, and choose Get started.
• You can either select a suggested prompt or describe your question in your

own words.
• Copilot will analyze and visualize insights based on your input.

• Focus on what matters by using Copilot to highlight, filter, and sort your data.
• If you already have access, give it a try by selecting your data and using Copilot.

• Copilot suggests formula columns for complex calculations.
• Activate Copilot, and it will provide formula column recommendations to

enhance your data analysis.

• Open your Excel worksheet.
• Go to the Home tab and click the Copilot icon.
• The Copilot chat panel will appear on the right.
• If your workbook doesn’t have Copilot active, it can convert

your data into an Excel table for you.
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Different Copilot Use Cases 
Microsoft Copilot in Power BI to enhance your data analysis and report creation. Copilot 
in Power BI leverages natural language and AI to assist you throughout your reporting 
process. Here’s what you need to know:

1. Enabling Copilot in Power BI:

• To enable Copilot, follow these steps:
- Launch Power BI Desktop.
- Navigate to File > Options and Settings >

Preview Features.
- Enable Quick Measure Suggestions.
- Close and reopen Power BI Desktop to verify

that Copilot is active.

2. Generative AI for Report Creation:

• Copilot allows you to create reports
automatically by:

- Selecting a topic for a report.
- Prompting Copilot with specific topics.

• It generates visuals, analysis, and text
narratives based on your input.

• You can create a narrative visual that
summarizes data on your report canvas,
offering an easy-to-read guide for end users.

3. Interacting with Copilot:

• Open the Copilot pane within Power BI.

• Ask Copilot to:
- Create a report page.
- Summarize a page or an entire report.
- Generate synonyms for Q&A capabilities.

• Copilot provides a starting point, which
you can modify to meet your exact
requirements.

4. Supported SKUs:

• Copilot is available for paid SKUs (F64 or
higher, or P1 or higher).

• It’s not supported on trial SKUs.

• Ensure your Fabric tenant admin enables
the necessary settings for Copilot.
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Different Copilot Use Cases 
Microsoft Copilot in Edge to enhance your browsing experience and productivity. 
Copilot is an AI-powered feature that assists you with various tasks right from your 
browser sidebar. Here’s how you can make the most of it:

1. Accessing Copilot in the Sidebar:

• To try Copilot, sign into Microsoft Edge and
select the Copilot icon in the browser sidebar.

• Feature availability and functionality may
vary based on your device type, market, and
browser version.

2. Examples of What Copilot Can Do:

• Copilot can perform searches and provide
answers related to the page you’re viewing.
For instance:

“What did I miss from the 3PM meeting 
yesterday?”

“Summarize the Q3 performance metrics for 
me in an Excel spreadsheet.”

“Compare this coffee maker to {other brand} 
and put it in a table.”

“Would this plant thrive in an east-facing 
window?”

“Key takeaways of this report.”

• Make sure to give Copilot permission by
toggling on Page context in the sidebar.

3. Tips and Tricks:

• You can now ask Copilot questions, have it
summarize content, and review PDFs.

•  Turn on Page context by going to More
options > Notification and App settings at
the top of your Copilot in the sidebar.

•  Copilot can compare products, summarize
documents (including PDFs), organize tabs,
and more.

•  You can also access Copilot directly from the
Edge app menu for on-the-go assistance.

4. Image Customization:

• Don’t settle for less than perfect images!You
can tweak them to your liking by asking
Copilot for changes in subsequent messages.
For example, adjust the color scheme, style,
or background details of your images.
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Different Copilot Use Cases 
Microsoft Copilot in Windows 11. Copilot is an AI-powered feature that acts as your 
digital assistant, answering questions, summarizing content, customizing settings, 
and connecting across your preferred apps. Here’s how to get started:

Enabling Copilot in Windows 11 Settings

• By default, Copilot is turned on and represented by a permanent icon on the taskbar.
• If you can’t find it on your taskbar, follow these steps:

1. Open the Settings app on your Windows 11 PC.
2. Select the Personalization section from the

sidebar on the left.

3. Scroll down and choose Taskbar.
4. Turn On the toggle switch next to

the Copilot option.

• Once enabled, you’ll see the Copilot icon on the taskbar.

What Can Copilot Assist With?

• Copilot uses natural language processing to understand your requests.
• It can help with tasks like navigating the operating system, troubleshooting technical

issues, finding documents or files, and performing productivity actions.
• Start a new conversation by clicking the ‘New topic’ button near the text field or

selecting ‘Refresh’ from the three dots at the top.
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Different Copilot Use Cases 

Launching and Using Copilot in Windows

• You can launch Copilot in two ways:
1. Click the Copilot icon on the taskbar.
2. Use the keyboard shortcut Windows + C.

• Copilot will appear as a sidebar on the right edge of your screen, running
alongside your open app windows.

• It won’t overlap with your desktop content.
• Copilot offers three conversation modes:

1. More Creative: Imaginative and inventive, but may lack accuracy.
2. More Precise: Highly accurate and detailed, but less creative.
3. More Balanced: A blend of creativity and accuracy.

• Choose the mode that suits your requirements.
• Copilot may show sample tasks from its capabilities. Click a task to try it out.

1. For example, it might suggest “Turn on dark mode.” Confirm or deny as needed.

• Interact with Copilot through voice commands or text inputs.

If you would like more information visit us at www.uscloud.com

https://www.uscloud.com/
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